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Chapter 177

Equivalence Tests for
the Difference of Two
Proportions in a 2x2
Cross-Over Design
Introduction
Senn (2002) defines a cross-over design as one in which each subject receives all treatments and the objective is
to study differences among the treatments. The name cross-over comes from the most common case in which
there are only two treatments. In this case, each subject crosses over from one treatment to the other. It is assumed
that there is a washout period between treatments during which the response returns back to its baseline value. If
this does not occur, there is said to be a carry-over effect.
A 2×2 cross-over design contains to two sequences (treatment orderings) and two time periods (occasions). One
sequence receives treatment A followed by treatment B. The other sequence receives B and then A. The design
includes a washout period between responses to make certain that the effects of the first drug do not carry over to
the second. Thus, the groups in this design are defined by the sequence in which the drugs are administered, not
by the treatments they receive. Indeed, higher-order cross-over designs have been used in which the same
treatment is used at both occasions.
Cross-over designs are employed because, if the no-carryover assumption is met, treatment differences are
measured within a subject rather than between subjects—making a more precise measurement. Examples of the
situations that might use a cross-over design are the comparison of anti-inflammatory drugs in arthritis and the
comparison of hypotensive agents in essential hypertension. In both cases, symptoms are expected to return to
their usual baseline level shortly after the treatment is stopped.
The sample size calculations in the procedure are based on the formulas presented in Chow, Shao, Wang, &
Lokhnygina (2018).

Advantages of Cross-Over Designs
A comparison of treatments on the same subject is expected to be more precise. The increased precision often
translates into a smaller sample size. Also, patient enrollment into the study may be easier because each patient
will receive both treatments. Finally, it is often more difficult to obtain a subject than to obtain a measurement.
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Disadvantages of Cross-Over Designs
The statistical analysis of a cross-over experiment is more complex than a parallel-group experiment and requires
additional assumptions. It may be difficult to separate the treatment effect from the period effect, the carry-over
effect of the previous treatment, and the interaction between period and treatment.
The design cannot be used when the treatment (or the measurement of the response) alters the subject
permanently. Hence, it should not be used to compare treatments that are intended to provide a cure.
Because subjects must be measured at least twice, it is often more difficult to keep patients enrolled in the study.
It is arguably simpler to measure a subject once than to obtain their measurement twice. This is particularly true
when the measurement process is painful, uncomfortable, embarrassing, or time consuming.

Technical Details
The 2×2 crossover design may be described as follows. Randomly assign the subjects to one of two sequence
groups so that there are 𝑛𝑛1 subjects in sequence one and 𝑛𝑛2 subjects in sequence two. In order to achieve design
balance, the sample sizes 𝑛𝑛1 and 𝑛𝑛2 are assumed to be equal so that 𝑛𝑛1 = 𝑛𝑛2 = 𝑁𝑁/2.
Sequence one is given treatment A followed by treatment B. Sequence two is given treatment B followed by
treatment A.

The design can be analyzed using a simple z-test if we ignore period and sequence effects or using a more
complex random effects logistic regression model that adjusts for period and sequence effects. The sample size
calculations herein ignore period and sequence effects. Julious (2010) suggests on page 175 that the bias due to
ignoring period effects if a period-adjusted analysis is planned is not great and that sample size calculations that
ignore period effects are adequate.

Cross-Over Design
The discussions that follow summarize the results in Chow, Shao, Wang, & Lokhnygina (2018). Consider a 2×2
cross-over design and let 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 represent the binary response (0 or 1) from the jth subject (j = 1, …, ni) in the ith
sequence (i = 1, 2) given the kth treatment (k = 1, 2). Here we assume that the sample sizes are equal in both
sequences such that 𝑛𝑛1 = 𝑛𝑛2 = 𝑛𝑛. If replicates are taken from each subject (as in a 2×2m replicated cross-over

design) then 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 = 𝑥𝑥̅𝑖𝑖𝑖𝑖𝑖𝑖. =

1
�∑𝑚𝑚
𝑙𝑙=1 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 �,
𝑚𝑚

where 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 represents the lth binary response replicate (l = 1, …, m)

from the jth subject (j = 1, …, ni) in the ith sequence (i = 1, 2) given the kth treatment (k = 1, 2). The observations
taken from the same subject may be correlated with one another. If we assume no sequence and period effects,
then we can state that 𝑃𝑃�𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 = 1� = 𝑃𝑃𝑘𝑘 . Further define the paired differences of treatment – control for each
subject within each sequence as
𝑑𝑑𝑖𝑖𝑖𝑖 = 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖

and the overall treatment – control difference as

= 𝑥𝑥𝑖𝑖𝑖𝑖1 − 𝑥𝑥𝑖𝑖𝑖𝑖2

𝛿𝛿 = 𝑃𝑃𝑇𝑇 − 𝑃𝑃𝐶𝐶

= 𝑃𝑃1 − 𝑃𝑃2 .
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The overall difference can be estimated as
𝛿𝛿̂ =

𝑛𝑛

2

1
� � 𝑑𝑑𝑖𝑖𝑖𝑖 .
2𝑛𝑛
𝑖𝑖=1 𝑗𝑗=1

The estimated difference is asymptotically normally distributed with variance 𝜎𝜎𝑑𝑑2 , which can be estimated as
𝜎𝜎�𝑑𝑑2

where

𝑛𝑛

2

1
2
=
� ��𝑑𝑑𝑖𝑖𝑖𝑖 − 𝑑𝑑̅𝑖𝑖. � ,
2(𝑛𝑛 − 1)
𝑖𝑖=1 𝑗𝑗=1
𝑛𝑛

1
𝑑𝑑̅𝑖𝑖. = � 𝑑𝑑𝑖𝑖𝑖𝑖 .
𝑛𝑛
𝑗𝑗=1

The standard deviation, then, is

𝑆𝑆𝑆𝑆 = 𝜎𝜎𝑑𝑑 = �𝜎𝜎𝑑𝑑2

with estimate

� = 𝜎𝜎�𝑑𝑑 = �𝜎𝜎�𝑑𝑑2 .
𝑆𝑆𝑆𝑆

Equivalence Test Statistics
The null and alternative hypotheses for an equivalence test are

or equivalently

𝐻𝐻0 : 𝑃𝑃𝑇𝑇 − 𝑃𝑃𝐶𝐶 ≤ 𝐷𝐷0𝐿𝐿 or 𝑃𝑃𝑇𝑇 − 𝑃𝑃𝐶𝐶 ≥ 𝐷𝐷0𝑈𝑈
𝐻𝐻0 : 𝛿𝛿 ≤ 𝐷𝐷0𝐿𝐿 or 𝛿𝛿 ≥ 𝐷𝐷0𝑈𝑈

vs

vs

𝐻𝐻𝐴𝐴 : 𝐷𝐷0𝐿𝐿 < 𝑃𝑃𝑇𝑇 − 𝑃𝑃𝐶𝐶 < 𝐷𝐷0𝑈𝑈

𝐻𝐻𝐴𝐴 : 𝐷𝐷0𝐿𝐿 < 𝛿𝛿 < 𝐷𝐷0𝑈𝑈

where 𝐷𝐷0𝐿𝐿 and 𝐷𝐷0𝑈𝑈 are the lower and upper equivalence bounds, respectively (i.e. the smallest and largest
differences (𝑃𝑃𝑇𝑇 − 𝑃𝑃𝐶𝐶 ) for which the treatment and control will be considered equivalent).

The power and sample size calculations are based on the two one-sided test (TOST) statistics

𝛿𝛿̂ − 𝐷𝐷0𝐿𝐿
𝛿𝛿̂ − 𝐷𝐷0𝑈𝑈
and 𝑍𝑍𝑈𝑈 =
𝜎𝜎�𝑑𝑑
𝜎𝜎�𝑑𝑑
√2𝑛𝑛
√2𝑛𝑛
which are each asymptotically distributed as standard normal under the null hypothesis. The null hypothesis is
rejected in favor of the alternative at level 𝛼𝛼 using the TOST procedure if
𝑍𝑍𝐿𝐿 =

𝑍𝑍𝐿𝐿 > 𝑍𝑍1−𝛼𝛼

and

𝑍𝑍𝑈𝑈 < 𝑍𝑍𝛼𝛼

where 𝑍𝑍1−𝛼𝛼 is the upper 1 − 𝛼𝛼 percentile and 𝑍𝑍𝛼𝛼 is the lower 𝛼𝛼 percentile of the standard normal distribution.
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Equivalence Power Calculation
Derived from Chow, Shao, Wang, & Lokhnygina (2018) page 85, the power for an equivalence test of
𝐻𝐻0 : 𝛿𝛿 ≤ 𝐷𝐷0𝐿𝐿 or 𝛿𝛿 ≥ 𝐷𝐷0𝑈𝑈 versus 𝐻𝐻𝐴𝐴 : 𝐷𝐷0𝐿𝐿 < 𝛿𝛿 < 𝐷𝐷0𝑈𝑈 is given as
Φ�

𝐷𝐷0𝑈𝑈 − 𝛿𝛿1
𝐷𝐷0𝐿𝐿 − 𝛿𝛿1
− 𝑍𝑍1−𝛼𝛼 � − Φ � 𝜎𝜎
+ 𝑍𝑍1−𝛼𝛼 �
𝜎𝜎𝑑𝑑
𝑑𝑑
√2𝑛𝑛
√2𝑛𝑛

where Φ() is the standard normal distribution function, 𝛿𝛿1 is the actual value of the difference under the
alternative hypothesis, and 𝑍𝑍1−𝛼𝛼 is the upper 1 − 𝛼𝛼 percentile of the standard normal distribution. The sample size
is determined using a binary search of possible values for n.

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be calculated from the values of the other parameters. Under most
conditions, you would select either Power or Sample Size.
Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha level.
Select Power when you want to calculate the power of an experiment that has already been run.
Select Effect Size (D1) when you want to calculate the minimum effect size that can be detected for a particular
design.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of
equal means when in fact the means are different.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal
means when in fact the means are equal.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
n (Sample Size per Sequence)
This is the sample size of each sequence or group (AB and BA) in the cross-over design. The individual sequence
sample sizes are assumed to be equal such that the total sample size is equal to N = 2n.
You can enter a single value such as 50 or a list of values using the syntax 50 100 150 200 250 or 50 to 250 by 50.

Effect Size – Equivalence Differences
D0.U (Upper Equivalence Difference)
Specify the upper equivalence bound for the difference. This value along with the lower equivalence difference
(D0.L) is used to setup the hypothesis test. This value represents the largest difference (Pt - Pc) for which the
treatment and control will be considered equivalent.
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 or 0.5 to 0.7 by 0.1 in the range
0 < D0.U < 1 and D0.U > D1.
D0.L (Lower Equivalence Difference)
Specify the lower equivalence bound for the difference. This value along with the upper equivalence difference
(D0.U) is used to setup the hypothesis test. This value represents the smallest difference (Pt - Pc) for which the
treatment and control will be considered equivalent.
For symmetric bounds, enter -D0.U. This is the default. You can also enter a single value such as -0.5 or a series
of values such as -0.7 -0.6 -0.5 or -0.7 to -0.5 by 0.1 in the range -1 < D0.L < 0 and D0.L < D1. Note that if you
enter values for D0.L other than -D0.U, they are used in pairs with the values of D0.U. Thus, the first values of
D0.U and D0.L are used, then the second values of each are used, and so on.

Effect Size – Actual Difference
D1 (Actual Difference)
Enter a value for the actual difference (Pt - Pc) at which power is calculated.
You can enter a single value such as 0 or a series of values such as 0 0.1 0.2 or 0 to 0.2 by 0.1 in the range
-1 < D1 < 1 and D0.L < D1 < D0.U.
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Effect Size – Standard Deviation of Paired
Differences
Standard Deviation (SD)
Enter a value for the standard deviation of the paired differences, SD.
Estimating SD using Previous 2x2 Cross-Over Data
The standard deviation may be estimated using cell counts from a previous 2x2 cross-over study with n subjects
per sequence as described on pages 82 and 83 of Chow, Shao, Wang, & Lokhnygina (2018).
Assume xᵢⱼ₁ is the binary treatment response of the jth subject (j = 1 to n) in the ith sequence (i = 1,2), and xᵢⱼ₂ is
the binary control or reference response of the jth subject (j = 1 to n) in the ith sequence (i = 1,2). Note that the
number of subjects in sequence 1 is equal to the number of subjects in sequence 2 such that n1 = n2 = n.
Define
dᵢⱼ = xᵢⱼ₁ - xᵢⱼ₂
dbarᵢ = (1/n)Σⱼdᵢⱼ
The formula for SD is then
SD = √[(ΣᵢΣⱼ(dᵢⱼ - dbarᵢ)²)/(2(n-1))].
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Example 1 – Power Analysis
Suppose you want to consider the power of an equivalence test of the hypotheses 𝐻𝐻0 : 𝛿𝛿 ≤ −0.2 or 𝛿𝛿 ≥ 0.2 versus
𝐻𝐻𝐴𝐴 : −0.2 < 𝛿𝛿 < 0.2 in a balanced cross-over design with a binary endpoint where the test is computed based on
the difference for sequence sample sizes between 50 and 200. Let’s assume that the actual difference is 0 and the
estimated standard deviation of the paired differences is 1. The significance level is 0.05.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Equivalence Tests for the Difference of Two Proportions in a 2x2 Cross-Over Design
procedure window by expanding Proportions, then Cross-Over (2x2) Design, then clicking on Equivalence,
and then clicking on Equivalence Tests for the Difference of Two Proportions in a 2x2 Cross-Over Design.
You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Alpha ....................................................... 0.05
n (Sample Size per Sequence) ............... 50 to 200 by 50
D0.U (Upper Equivalence Difference) .... 0.2
D0.L (Lower Equivalence Difference) ..... -D0.U
D1 (Actual Difference) ............................ 0
Standard Deviation (SD) ......................... 1

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an Equivalence Test ────────────────────────────────────────────
H0: Pt - Pc ≤ D0.L or Pt - Pc ≥ D0.U vs. H1: D0.L < Pt - Pc < D0.U

Power
0.27752
0.76342
0.93113
0.98148

Sequence
Sample
Size
n
50
100
150
200

Total
Sample
Size
N
100
200
300
400

Lower
Upper
Equiv.
Equiv.
Actual
Difference Difference Difference
D0.L
D0.U
D1
-0.200
0.200
0.000
-0.200
0.200
0.000
-0.200
0.200
0.000
-0.200
0.200
0.000

Standard
Deviation
SD
1.000
1.000
1.000
1.000

Alpha
0.050
0.050
0.050
0.050

References
Chow, S.C., Shao, J., Wang, H., and Lokhnygina, Y. 2018. Sample Size Calculations in Clinical Research, Third
Edition. Chapman & Hall/CRC. Boca Raton, Florida.
Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
n is the sample size in each sequence (or group).
N is the total sample size from both sequences. The sample is divided equally among sequences.
D0.L is the lower equivalence difference used to specify the hypothesis test.
D0.U is the upper equivalence difference used to specify the hypothesis test.
D1 is the actual difference at which power is calculated.
SD is the standard deviation of paired differences. This is estimated from a previous study.
Alpha is the probability of rejecting a true null hypothesis. It should be small.
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Summary Statements ─────────────────────────────────────────────────────────
For a 2x2 cross-over design, a sample size of 50 in each sequence for a total of 100 achieves
27.752% power to detect a difference of 0.000 using an equivalence test with lower and upper
equivalence bounds of -0.200 and 0.200, respectively, with a significance level of 0.050 when
the standard deviation of paired differences is 1.000.
Dropout-Inflated Sample Size ────────────────────────────────────────────────────

Dropout Rate
20%
20%
20%
20%

── Sample Size ──
n
N
50
100
100
200
150
300
200
400

Dropout-Inflated
Enrollment
── Sample Size ──
n'
N'
63
126
125
250
188
376
250
500

Expected
Number of
── Dropouts ──
d
D
13
26
25
50
38
76
50
100

Definitions
Dropout Rate (DR) is the percentage of subjects (or items) that are expected to be lost at random during the
course of the study and for whom no response data will be collected (i.e. will be treated as "missing").
n and N are the evaluable group and total sample sizes, respectively, at which power is computed (as entered
by the user). If n subjects from each group are evaluated out of the n' subjects that are enrolled in the
study, the design will achieve the stated power. N = 2n.
n' and N' are the number of subjects that should be enrolled in the study in order to end up with n and N
evaluable subjects, based on the assumed dropout rate. n' is calculated by inflating n using the formula n'
= n / (1 - DR), with n' always rounded up. (See Julious, S.A. (2010) pages 52-53, or Chow, S.C., Shao, J.,
and Wang, H. (2008) pages 39-40.). N' = 2n'.
d and D are the expected number of group and total dropouts, respectively. d = n' - n and D = 2d.

Charts Section

This report shows the values of each of the parameters, one scenario per row. This plot shows the relationship
between sample size and power. We see that a sample size of just over 100 per sequence is required for 80%
power.
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Example 2 – Calculating Sample Size when Estimating the
Standard Deviation from a Previous Study
This example demonstrates how to calculate the sample size when estimating the standard deviation of the paired
differences from data in a previous study using the method in Chow, Shao, Wang, & Lokhnygina (2018) on pages
82 and 83. In this example we’ll find the sample size required to detect a difference of 0 with 90% power in a test
of the hypotheses 𝐻𝐻0 : 𝛿𝛿 ≤ −0.2 or 𝛿𝛿 ≥ 0.2 versus 𝐻𝐻𝐴𝐴 : −0.2 < 𝛿𝛿 < 0.2 at a significance level of 0.05, with the
standard deviation estimated using cell counts from a previous 2x2 cross-over study with equal sample size per
sequence.
Assume that the following results were previously obtained from 280 subjects in a simple 2x2 cross-over trial
comparing two inhalation devices, A and B. These results are similar to Table 3.2 of Lui (2016) on page 36 with a
slight adjustment to sequence 1 that makes the sample sizes equal per sequence.
SEQUENCE 1 (Control (A) → Treatment (B))

Period 1
(A)

Yes
No

Total

Yes
27
15
42

Period 2
(B)
No

Total

57

72

41
98

67

SEQUENCE 2 (Treatment (B) → Control (A))

Period 1
(B)

140

Yes
38

Yes

32

No

Total

70

Period 2
(A)
No

Total

54

86

16
70

54

140

The paired differences of treatment – control for each subject within each sequence are
𝑑𝑑𝑖𝑖𝑖𝑖 = 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖

= 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 − 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖

If 𝑥𝑥𝑖𝑖𝑖𝑖𝑖𝑖 is a binary variable, then 𝑑𝑑𝑖𝑖𝑖𝑖 can take on the values 0, 1, and -1. If we summarize the results in sequence 1,
then there are 15 subjects with 𝑑𝑑𝑖𝑖𝑖𝑖 = 1 (B = “Yes”, A = “No”), 41 subjects with 𝑑𝑑𝑖𝑖𝑖𝑖 = −1 (B = “No”, A =
“Yes”), and 27 + 57 = 84 subjects with 𝑑𝑑𝑖𝑖𝑖𝑖 = 0 (B = “Yes”, A = “Yes” or B = “No”, A = “No”). The average
paired difference, then, for sequence 1 is
̅ =
𝑑𝑑1.

𝑛𝑛

1
� 𝑑𝑑1𝑗𝑗
𝑛𝑛
𝑗𝑗=1

15(1) + 41(−1) + 84(0)
140
15 − 41
=
140
=

= −0.1857.
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Similarly, the average paired difference from sequence 2 is
𝑑𝑑̅2. =

𝑛𝑛

1
� 𝑑𝑑2𝑗𝑗
𝑛𝑛
𝑗𝑗=1

16(1) + 32(−1) + 92(0)
140
16 − 32
=
140

=

= −0.1143.

The estimated overall treatment – control difference is

2

𝑛𝑛

1
� � 𝑑𝑑𝑖𝑖𝑖𝑖
𝛿𝛿̂ =
2𝑛𝑛
𝑖𝑖=1 𝑗𝑗=1

̅ + 𝑑𝑑̅2.
𝑑𝑑1.
2
−0.1857 − 0.1143
=
2

=

= −0.15.

The estimated variance of paired differences, then, is
𝜎𝜎�𝑑𝑑2

2

𝑛𝑛

1
2
=
� ��𝑑𝑑𝑖𝑖𝑖𝑖 − 𝑑𝑑̅𝑖𝑖. �
2(𝑛𝑛 − 1)
=

𝑖𝑖=1 𝑗𝑗=1

15(1 + 0.1857)2 + 41(−1 + 0.1857)2 + 84(0 + 0.1857)2 + 16(1 + 0.1143)2 + 32(−1 + 0.1143)2 + 92(0 + 0.1143)2
2(139)

= 0.3502

with estimated standard deviation
� = 𝜎𝜎�𝑑𝑑
𝑆𝑆𝑆𝑆

= �𝜎𝜎�𝑑𝑑2

= √0.3502
= 0.5917.
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Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Equivalence Tests for the Difference of Two Proportions in a 2x2 Cross-Over Design
procedure window by expanding Proportions, then Cross-Over (2x2) Design, then clicking on Equivalence,
and then clicking on Equivalence Tests for the Difference of Two Proportions in a 2x2 Cross-Over Design.
You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.90
Alpha ....................................................... 0.05
D0.U (Upper Equivalence Difference) .... 0.2
D0.L (Lower Equivalence Difference) ..... -D0.U
D1 (Actual Difference) ............................ 0
Standard Deviation (SD) ......................... 0.5917

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an Equivalence Test ────────────────────────────────────────────
H0: Pt - Pc ≤ D0.L or Pt - Pc ≥ D0.U vs. H1: D0.L < Pt - Pc < D0.U

Power
0.90447

Sequence
Sample
Size
n
48

Total
Sample
Size
N
96

Lower
Upper
Equiv.
Equiv.
Actual
Difference Difference Difference
D0.L
D0.U
D1
-0.200
0.200
0.000

Standard
Deviation
SD
0.592

Alpha
0.050

This report indicates that the required sample size for 90% power is 48 per sequence for a total of 96.
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Example 3 – Calculating Sample Size (Validation using Chow,
Shao, Wang, & Lokhnygina (2018))
On page 86, Chow, Shao, Wang, & Lokhnygina (2018) presents an example of finding the sample size required to
detect a difference of 0 in an equivalence test with a margin of 0.2 with 80% power at a significance level of 0.05
when the standard deviation of paired differences is 0.5. They compute the required sample size to be 27 per
sequence.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Equivalence Tests for the Difference of Two Proportions in a 2x2 Cross-Over Design
procedure window by expanding Proportions, then Cross-Over (2x2) Design, then clicking on Equivalence,
and then clicking on Equivalence Tests for the Difference of Two Proportions in a 2x2 Cross-Over Design.
You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and
choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.8
Alpha ....................................................... 0.05
D0.U (Upper Equivalence Difference) .... 0.2
D0.L (Lower Equivalence Difference) ..... -D0.U
D1 (Actual Difference) ............................ 0
Standard Deviation (SD) ......................... 0.5

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results for an Equivalence Test ────────────────────────────────────────────
H0: Pt - Pc ≤ D0.L or Pt - Pc ≥ D0.U vs. H1: D0.L < Pt - Pc < D0.U

Power
0.80452

Sequence
Sample
Size
n
27

Total
Sample
Size
N
54

Lower
Upper
Equiv.
Equiv.
Actual
Difference Difference Difference
D0.L
D0.U
D1
-0.200
0.200
0.000

Standard
Deviation
SD
0.500

Alpha
0.050

The result from PASS matches the result in Chow, Shao, Wang, & Lokhnygina (2018) exactly.
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